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INTRODUCTION

There are lots of File Finder utilities available for Windows 3.x but most of them do just that--find
files. Filer is a bit different; it finds files, but does a lot more too. Here's just some of what you can
do with this program:

**Locate any  file  on  any  hard  disk  drive  or  partition,  or  CD-ROM drive,  using  normal  DOS
wildcards.
**Search the current drive or all hard drives and partitions.
**Find Duplicate Files anywhere on your system.
**Display just the files found, or the files along with the complete directory structure of the disk(s).
**Display just the tree structure of your drive or drives.
**See detailed information about any file. 
**Print a formatted copy of your search results on any Windows-compatible printer. You can then
print a list showing the directory structure of your disk(s) for future reference.
**View Graphics files found by Filer. If they are BMP, DIB, WMF, RLE, PCX, PIC, TGA, JPG or
ICO files, you'll see the image itself on the screen. 
**Hear sound files, including WAV, MID, and RMI Files.
**View AVI  (Video for  Windows),  FLI,  FLC (AutoDesk Animations)  and  MOV (QuickTime for
Windows) Movies. View in a Window or full Screen.
**Preview TrueType Fonts, even if they aren't installed.
**Delete a single file, or selected files found by Filer. A confirmation box prevents costly errors.
*Copy files to new directories.
*Move files to new directories, deleting old files after checking the validity of the new copy.
**Wipe Files, then delete them, to prevent snoopers from having access to your data.
**Search for text within the files found by Filer. This lets you find the exact file you wish to see,
based on its contents. The text search allows up to four search strings, which can be linked with
AND/OR Boolean options. If you choose AND, you can search either for linked text in the same
paragraph, or in the entire file. Searching is as fast as possible.
**Launch files you find in either the File Search or Text Search windows. You can run an EXE,
BAT, COM, or PIF file to start that application, whether it's a DOS or Windows application. If a file
has a Windows association with a program, you can load the file into that application 
**Set  customized  associations for  data  files.  Normally,  Filer uses  the  associations  you've
specified in Windows. It reads the WIN.INI file and parses the associations, then uses that data to
launch file. However, you can set up to 36 customized associations for use in launches. Filer
always uses your custom associations rather than the default  Windows associations if it  finds
them.
**Edit or run .BAT or .PIF files. That way, you can choose to edit a batch file or PIF file rather
than run the file. Check the options menu.
**Keep informed of the state of your search at all times. Filer shows you the directories or files
currently being searched.
**Use the [Zoom] button to view images too large to display in the sample window.
**Get Help by Right-Clicking on any Filer object.



LICENSE INFORMATION
This is the unregistered version of Filer 4.0. Filer is a shareware program. You may try this copy 
of the program for a period not to exceed 30 days to determine whether or not it is suitable for 
your needs. After that time, if you continue to use the program, you must pay for your copy and 
register with the author. To pay and register, use the OsoSoft Program Info command in the 
Help Menu to print the Order form. The Registration payment for this program is $25.

You can also pay with a Visa or MasterCard by calling OsoSoft at (805) 528-1759 during normal 
West Coast business hours. Or FAX your credit card order to (805) 528-3074. OsoSoft programs 
may also be ordered on CompuServe in the SWREG forum. SWREG orders will be charged to 
your CompuServe account.

Registered users receive the very latest version of the program, a printed manual, automatic 
notification of major upgrades, and support. In addition, when you register, you'll always be 
entitled to upgrade to new registered versions at no charge on the OsoSoft BBS at (805) 528-
3753 or in the OsoSoft support section on CompuServe (GO OSOSOFT). Registered users are 
entitled to unlimited free support by telephone, fax, on the OsoSoft BBS, and in OsoSoft's  
Compuserve support section. Registered users will also receive an offer for a Free Trial 
Membership on CompuServe, where OsoSoft has a support section. To access the OsoSoft 
support section, give the command: GO OSOSOFT.

Unregistered users receive only a minimum of support, limited to some installation help, if 
necessary. If you call the OsoSoft voice number for support as an unregistered user, you will be 
asked to register and pay at that time by credit card.

Registration Reminder Screens
From time to time at random, while viewing files or when you exit Filer you'll occasionally see the  
About window, which reminds you to pay for your copy of the program. This screen will not 
appear in registered versions. To hear a message, if you have a sound card, click on the speaker 
button. To access the Order form, click the [Register] button. Click [OK] to exit to Windows or to 
return to Filer.

Users of this program, along with traditional shareware distributors may distribute copies of  the 
shareware versions of this program, but only under the terms described in the VENDOR.DOC file 
included with this copy of the program. All commercial distributors MUST read that file and abide 
by the distribution rules contained in that file. Violations of the distribution license in 
VENDOR.DOC may result in prosecution under appropriate copyright laws of the United States 
and other countries.

Filer and all related files, including this documentation are Copyright 1991,1995 by OsoSoft. All 
rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals (ASP) and the Software 
Publishers' Association (SPA).

OsoSoft
1472 Sixth Street
Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
FAX Order Line: (805) 528-3074
CompuServe ID: 71571,222 or GO OSOSOFT



HOURS
OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. Calls outside those hours 
are not appreciated.

ASP OMBUDSMAN NOTICE

This program is produced by a member of the Association of Shareware Professionals (ASP). 
ASP wants to make sure that the shareware principle works for you. If you are unable to resolve a
shareware-related problem with an ASP member by contacting that member directly, ASP may be
able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members' products. Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI 49422-9427 USA FAX 619-788-2765 or send a 
CompuServe message via CompuServe mail to ASP Ombudsman 70007,3536.

SYSTEM REQUIREMENTS 

Filer requires a 386 or better PC, Windows 3.1 operating in Enhanced Mode, and a minimum of 4
MB of memory. You'll also need 1 MB of disk space for installation. You'll also need a fully-
supported Windows-compatible printer and a valid video display with 640 X 480 resolution 
minimum.

INSTALLATION

NOTE: If you are installing this program as part of OsoSuite 1.1, skip
these installation instructions. The program was installed correctly 
when you used the instructions in OSOSUITE.WRI. If you did not install 
using those instructions, please read OSOSUITE.WRI before installation.
The Shareware version of Filer use a manual installation technique. The Registered Version 
includes an automated installation program. To install this program, take the following steps. If 
you need help with any of the file and directory procedures, consult your Windows or DOS 
Manual.

1. Copy all files from the distribution diskette or the ZIP file containing the program into a directory
on your hard disk. OsoSoft recommends that you create a directory called FILER for the files. 
WARNING: Do not install Filer in your WINDOWS\SYSTEM directory. If you do, Filer will not be 
able to display TrueType fonts. It is never a good idea to install any program in the WINDOWS\
SYSTEM directory.

2. Now, copy all files with the extensions DLL and VBX from the FILER directory into your 
WINDOWS\SYSTEM directory. If you're working from the DOS prompt while in the FILER 
directory, the commands would be:

COPY *.DLL C:\WINDOWS\SYSTEM
COPY *.VBX C:\WINDOWS\SYSTEM

Naturally, you'd substitute your own drive and directory information if you installed Windows in a 
different directory.

NOTE: If you do not wish to copy the DLL and VBX files to your WINDOWS\SYSTEM directory, 
you may leave them in the directory where you installed Filer. However, in this case, you must be 
sure that the Working Directory field is properly filled out in the File/Properties command in 
Program Manager.



NOTE: Once you have successfully copied all DLL and VBX files into the WINDOWS\SYSTEM 
directory, you may delete them from the Filer home directory, if desired, to save disk space. Do 
not, however, delete any other files.

VBRUN300.DLL REQUIRED
The shareware and online update versions also require VBRUN300.DLL, which must be installed
in the WINDOWS\SYSTEM directory. If you do not have a copy of that file, you may download it 
as VBRUN300.ZIP from the OsoSoft BBS at (805) 528- 3753, or obtain it from the source where 
you got your copy of the shareware version.

3. If Windows is not running, start it. Then, from the Program Manager, click once inside the 
program group where you want the Filer icon. Then, select the New command from the Program 
Manager's File menu. Make certain the Program Item option is selected, then click [OK] or press
<Enter>.

4. In the Description field of the resulting dialog box, type Filer, then press <Tab>.

5. In the Command Line field, type C:\FILER\FILER.EXE, substituting other drive and directory 
information, if necessary. Press <Tab>.

6. In the Working Directory field, type C:\FILER, or substitute other drive and path information, if
necessary. This field is necessary especially if you leave VBX and DLL files in the program 
directory.

7. Press <Enter> or click [OK] to complete the installation. The Filer icon will appear in the 
program group you selected earlier.

UnInstalling Filer

Should you choose to uninstall Filer, first remove the Filer Icon from Program manager. Click 
once on the icon, then press the <Del> key. Answer Yes to the prompt. To delete the program 
files, use File Manager or the DOS DELTREE command to remove the directory where you 
installed Filer. You may have copied several DLL and VBX files into your WINDOWS\SYSTEM 
directory. You may refer to the list of files in your distribution copy of the program for the names of
these files, which you may wish to delete. CAUTION: The DLL and VBX files installed with Filer 
may be required by other programs on your system. Use caution before deleting these files if you 
copied them into WINDOWS\SYSTEM.

Finding Files with Filer

After you start  Filer by double clicking on the  Filer icon, you'll  see the  Filer interface on your
screen. In the upper left of the screen is a text box for entering your search specification. Just
click inside the box and type your own search to replace the  *.* default entry. Use any normal
DOS wildcard criteria for your pattern. You can search for a single file by name or for any group of
files meeting your search criterion.  NOTE: Enter only filename specifications here, without any
path information. Filer can't search for directories.

Valid Wildcard Examples
You can use the asterisk (*) or the question mark (?) to indicate portions of a file specification in
the  search  pattern.  The  asterisk  represents  any  number  of  unknown  characters,  while  the
question mark indicates a single unknown character. Here are some examples of wildcard file
specifications:



*.* *.DOC *.T* R*.DOC *.D?C R???ME.*

COMM???.C* *.DLL LETTER??.DOC B*.*

Selecting Drives to Search
If  you want to search only a single drive, select that drive in the drive list  before starting the
search. Now, click the [Search Current Drive] button or the [Search All Drives] button to begin
your search. If you wish to cancel a search, click the [Cancel Search] button while the search is
in progress.

Filer will look for matching files, giving you a count of those it finds as it goes. Once the search is
done, a list box will appear containing all the matching files. Above the list box, you'll find a count
showing the number of files found. You can use the scroll bar to view more files. 

NOTE: Filer can only display 1000 files at one time in the list box. If more files are found, you'll
see the  More Files label. Click  [Next] to view additional files or  [Previous] to move back to a
previous list.

If there are already filenames in the file list box when you start a new search, Filer will ask if you
want to clear the list. If you answer [Yes], you'll start a new search from scratch. 

Note: Filer always returns to the C: Drive following each search.

Changing The Filer List's Font Size
On some systems, complete file specifications are too long to display visibly in the list window. If
a filename extends past the right edge of the list box, you can change to a smaller font to display
your filenames. To do this, give the  Small Fonts in List command in the  Options menu. To
return to the normal font size, give the command again.

Finding Duplicate Files with Filer

Over time, we all  accumulate duplicate files on our hard disks.  These duplicates can eat  up
precious hard disk space. Filer can locate and list those duplicate files to help you eliminate the
ones you don't need.

To do a simple search for duplicate files, set a pattern, just as you do for finding files. Then, click
the [Find Duplicate Filenames] button. Filer will first search for the files you specified, on your
hard disk or hard disks, but will skip any floppy or CD-ROM drives. It then searches the list for
duplicated files, cleans up the list, calculates the space used for duplicated files and shows you a
list.

HINT:  While  you can use the  *.* wildcard for  duplicate  searches,  this  can take a long time,
especially on today's large hard disks.  It's always best to search for duplicates by specifying
specific file extensions. For example, DLL files are often duplicated, so searching for *.DLL is a
good way to find duplicated files. 

If  you've already done a file search, you can click the  [Find Duplicate Filenames] button to
search your current list. Just answer [No] when asked if you want to clear the current list.

Viewing Files with Filer

After Filer finds your files, you can view details about any file by clicking once on the filename. If
the [Show File Details] check box is marked, a window will appear showing information about
your selected file, including date and time, size, attribute information, plus the type of file and



information on whether the file is associated with a program and whether Filer can view the file or
preview it.

Once you have a list, you can view individual files. Just double click on a filename, or click the
[View] button to view the currently selected file. For some file types which do not display directly
in  Filer, you'll see the first 4096 bytes of the file in the text box to the right. If you're viewing a
binary file, such as an  EXE file, some characters will appear as  +  or  - characters. These are
unprintable characters. Text files will appear normally, wrapped to fit inside the text box.

Viewing Graphics Files
If you've chosen a graphic with the extensions WMF, RLE, ICO, PCX, TGA, DIB, JPG, PIC, or
BMP, you'll see the image contained in the file. If the image is too large to display completely,
you'll see the upper left corner. To view the complete image, or as much as will fit on your entire
screen, click the [Zoom] button. To return to the Filer window, click the [Return] menu item on
the Zoom display.

NOTE: You must have the appropriate QuickTime for Windows MultiMedia driver installed to view
JPG files. If the driver is not installed, the file will not display.

NOTE ON GIF FILES:  Filer no longer displays GIF files, due to a patent dispute with UNISYS,
which demands royalties to be paid even for free or shareware software if  that  software can
display GIF files. OsoSoft regrets having to remove this format, but had no option.

Playing Sound Files
If you've selected a sound file with a  WAV,  MID, or RMI extension,  Filer will play the sound or
musical passage. NOTE: You must have a sound card installed to hear these files.

Showing Movie Files
If you've selected an AVI (Video for Windows), FLI, FLC (Autodesk Animator) or MOV (QuickTime
for Windows) file, Filer will display the movie in a window. For AVI files, you can click any of the
View buttons which appear to see the movie in a different size. For MOV and FLI files, use the
maximize button on the window to change the viewing size. 

NOTE: You must have the appropriate MultiMedia driver installed to view these files. If the driver
is not installed the file will simply refuse to display.

NOTE: You can stop the display of any movie file by clicking on another filename, by clicking
[Clear] or by clicking on the movie window for AVI files. Movies which display in a window with a
control bar may be controlled or closed by clicking on the control bar.

HINT: Many MultiMedia CD-ROM applications include  AVI and  MOV files which you can't see
from within the application. Most often, these files were left on the disk by accident, and can be
very interesting to view. Filer lets you explore your CD-ROM disks without loading the application.

Viewing TrueType Font Files
If you've selected a TrueType Font file (TTF), Filer can show you a sample of the font. You can
view both installed and uninstalled TrueType fonts in this way. This is especially useful if you have
a CD-ROM full of TrueType fonts, since it lets you preview the fonts without first installing them.
The name of the font appears above the font display. To view the complete character set for the
font, use the scroll bars to move down in the display.

HINT: You can type in the font sample display if you want to see how a particular phrase appears
in the previewed font.

Display Icons
If you've clicked on one of the graphics, sound files, or movie files listed above, you'll see an icon



near the file list when you select a file. You can also click this icon to display the file. If you've
selected a TTF file, you'll see a [Font Sample] button which serves the same purpose.

[Clear] Button
At  any  time,  you  can  click  the  [Clear] button  to  clear  a  file  display  and  return  to  the  File
Information screen.

Managing Files With Filer

Filer includes all the tools you need to manage your files. All of these tools depend on your first
getting a list of files on the screen with one of the search tools. Then, you select the files you want
to manage in the list.

Selecting Files
Most Filer commands can operate on either a single file or on multiple files. To select a single file,
just click on it. To select multiple adjacent files, just click and drag over the files you want to
select. To select multiple, non-adjacent files, hold down the <Ctrl> key while you click on the files
you want to select.

Deleting Files 
Filer can delete files from any non-write-protected drive. Start by selecting a file or files, then click
the [Delete Selected] button. Two confirmation boxes will appear, and if you click [Yes] on both,
you'll delete the selected files from the disk. If you've selected multiple files, another confirmation
box will appear with each file. Answer Yes to delete, No to skip that file, or Cancel to tell Filer to
stop confirming each deletion.

NOTE: If you know you do not want to confirm each deletion, uncheck the Prompt Before Each
Deletion menu command in the Options menu.

CAUTION: Make sure you really want to delete a file  or all  files before clicking  [Yes] in the
confirmation box! Once you've deleted the files, you will be able to get them back only with an
Undelete utility!

Wiping Files
When you delete files from your computer, the data is not removed from your disk. The file name
is merely removed from your drive's directory. A skilled person can still find and view your data. If
you need to remove a file completely from your drive and make it unreadable by anyone, use the
[Wipe File] button or the Wipe File and Delete command in the Utilities menu. This command
overwrites the file with a space character, then deletes the file. It completely obliterates all data
stored in that file.

CAUTION: This command works only on one file at a time, for safety's sake. Once a file has been
Wiped, not even an undelete utility can recover the data. Use this command with caution.

Copying Files
Filer lets you copy files from one location to another. First, select the files you want to copy in the
list box, then press the [Copy Selected] button. You'll be asked for a destination directory. Type
this information, including drive and path information if necessary, then click  [OK]. If you click
[Cancel], no files will be copied.

Renaming Files
Filer can rename files. Select a single file, then give the Rename File command in the Utilities
menu. Filer will present the current filename to you and let you edit it. When you click [OK] the file
will be renamed and the list updated. If you click [Cancel] no renaming will take place.



Moving Files
You can also move files from one directory to another.  Filer will  delete the original  file  after
confirming the copy. As with all commands, select the files you want to move, then press the
[Move  Selected] button.  You'll  be  asked  for  a  destination  directory.  Type  this  information,
including drive and path information if necessary, then click [OK]. If you click  [Cancel], no files
will be moved or deleted.

Comparing Files
When you're searching for or deleting duplicate files, or any other time you're using Filer, you may
want to compare two files to see if they're identical. To do this, select two files, then give the
Compare Files command in the Utilities menu. Filer will first compare the files sizes. If they do
not match the comparison ends. Next the files' dates and times will be compared. If they do not
match, Filer will inform you and ask you whether you want to continue. Then, Filer compares the
two  files,  byte  for  byte,  and  tells  you  whether  they  match  or  not.  NOTE:  With  large  files,
comparisons can take some time, so please be patient.

CAUTION: Be careful when deleting duplicate files to do a comparison on any files you're not
sure of. This is especially true with DLL, VBX, and other files required by Windows.

Your Directory Tree

By default,  Filer shows only the files found during the search.  However,  you can modify this
process. Two check boxes appear just above the list box.  If you check the [Show Directories
Only] check  box,  Filer will  ignore  your  search  specifications  and  list  your  drive(s)  directory
structure instead. This is a very useful tool. Printing a list of your computer's directory structure
can help you find directories later.

In addition, the [Don't List Directories] check box, which is normally checked, can be disabled. If
you do this, Filer will find the files, but will also list all your directories as well.

NOTE: While  Filer can list  directories, it  cannot delete, rename, move, or perform most other
management operations on them. If you try,  Filer will display a message and abort the action.
This is done for data safety reasons. If you want to manipulate directories, use File Manager
instead.

Printing File Lists

Filer's Print File List command in the File menu sends whatever is in the list box to your printer.
Printouts  have  a  1-inch  left  margin,  but  top  and  bottom  margins  are  whatever  your  printer
supports as its default.

Errors

Filer  automatically handles most errors you'll  encounter, informing you of the error when one
occurs.

Filer attempts to display all graphics files in the formats supported. However, a defective graphic
file in any format may cause a crash, including a General Protection Fault (GPF). If this occurs,
go ahead and exit the program in the GPF dialog box. You can then restart Filer. If this occurs, it's
a good idea to delete the offending file from your hard disk.

Executing, Launching, or Editing a File

Below the Filer list window is a large button, marked [Execute or Edit Selected File]. With a file



highlighted in the file list window, click this button. If the file is an EXE or COM file, you'll run that
program. 

WARNING:  Not  all  files  with  these  extensions  are  standalone  programs.  Be  sure  the
program you try  to  execute  will  run properly  before  pressing this  button.  Do not  run
any .EXE or .COM file with which you are not familiar. If you do so, some files may actually
damage your data. Proceed with extreme caution.

If the file is a PIF or BAT file, this button will either run the file, or load it into an appropriate editor,
depending on the setting for that file type in the Options menu. The default settings are to edit
BAT files and to run PIF files. Use the Options menu to change the settings if you want to do
something else.

If you run a DOS program from within Filer, it will run but, if the program executes, then normally
returns to the DOS prompt, you'll return to Filer instead.

For all other files, if you have an association for that file type in your WIN.INI file, Filer will load the
appropriate program, with your selected file loaded into the program for editing. You can view a
list  of file extensions and their associated applications with the  View Windows Associations
command in the Utilities menu.

Custom Associations

Not all file types have associations set up in Windows. This is especially true with files created by
non-Windows programs. For this reason,  Filer  lets you set up custom associations. To do this,
select the Utilities menu, then click on the Edit Custom Associations command. You'll see a
new window.

Type an file extension you want to associate with a program in the first field. Type the extension
completely, including the period character, as in .LST, but do not include any wildcard characters.

In the next field, type the complete file specification of the program you want to use to edit this file
type. Include the drive designation, the entire path and the complete filename, The entry should
look like:

C:\UTIL\LIST.EXE

Naturally, you'll substitute your own information.

If you like, click the [Test Program] button to load the program and make sure you have it right.

When you're satisfied, click the [Replace] button to add the association to the list. If you want to
add another association, click the [View Next] button and create anothe association. You can use
the [View Next] and [View Previous] buttons to step through the list. Just remember to click the
[Replace] Button after adding or editing an association.

To make these associations permanent, click the [Save] button. Filer  will save the associations
you create, loading them each time the program starts. To use the associations only in the current
session, and to return to the main Filer window, click the [Return] button.

NOTE: If you create associations for file extensions which also have a Windows association, your
custom association takes precedence when you click the [Execute or Edit Selected File] button.
You can use this feature to create special associations you'll use only with Filer.

SEARCHING FOR TEXT IN FILES



Filer has another very important and powerful feature. It can find files which include any text you
specify. This lets you locate any file on your hard disk by looking for internal data. This search
routine works in all files, including binary files. Here's what you do:

Start by doing a normal file search in the File Search window. For example, if you know that your
file will have the extension DOC, but don't know what drive it's on, use that extension, then use
the  [Search All Drives] button to locate all the  DOC files. For other searches, use whatever
search method works best to get a list of files which might contain the text you want. 

NOTE: You can search for text in ANY type of file, including binary files.

Once  Filer has found the target files and displays them in its file list,  click the  [Text Search]
button. You'll see a new window.

Specifying Search Text

In this window, you can specify up to 4 search strings. Just type them in in the fields provided.
Press <Enter> or <Tab> to move between fields. Since searches are done precisely for the text
you specify, make certain that you type what you want to find. A single word per field makes the
most sense.

After entering text, select the search options. Check either the [AND] or [OR] option, depending
on whether you want to search for files which contain text in all the fields or any of the fields. The
default is AND.

By default, Filer pays no attention to capitalization. If you want to search for text exactly as it is in
the fields, in a case-sensitive way, check the [Case Sensitive] box.

If you've selected  AND as your Boolean criterion, check the appropriate box to search for the
combination  of  text  in  all  fields  [Within  Paragraph] or  in  [Entire  File].  Use  the  [Within
Paragraph] option to find words which are close to each other.

Performing the Search

To start the search, click the  [Search] button.  Filer will  search through all  the files in the list
selected in the File Search window. You'll see which file is being searched at all times. When a
file  is  found  which  contains the  text  strings,  it  will  appear in  the  list.  To cancel  a  search in
progress, click the [Cancel Search] button with the hourglass cursor.

Once the search is complete, you'll have a list of all files containing your search text. You can
select  any  of  these  files,  then  execute  or  edit  the  file  using  either  Windows  or  custom
associations. To conduct a new search in the same list of files, press the [New Search] button.
This clears the list. 

To return to the File Search window, click the  [Return] button. Your list of found files remains
intact, allowing you to conduct a new file search, then continue your text search with another list
of files. You can repeat this process as often as you like. The file list will grow until you click the
[New Search] button.

Printing a List from the Text Search Window

As in the File Search window, you can print the list of files found in a text search by clicking the
[Print] button. This list  will  contain full  information on your search, including search text,  and
search criteria.



Getting Help in Filer

Filer can always display a brief help message for any command or on-screen object. Just click on
the object with the right mouse button. A message will appear in the title bar at the top of the Filer
Window.

If you need more help, use the commands below, in the Help menu:

Help with Filer
You'll see a new window. On the left is a Topic Index. On the right is the Help information. To view 
help on a topic, simply click on that topic in the Topic Index. To return to Filer, click the [Exit] 
button or the Return to Program command.

About Filer
View version information about Filer and find the OsoSoft support access numbers.

Help/OsoSoft Program Information
You'll see an order form for OsoSoft products. To learn more about a product, click the [Info] 
button next to that product's listing. To order, type the number of copies for each product . The 
rest is automatic. Click the [Print] button to print the form.


